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@

Help to analyze the results in the Quality Report

o Additional information about the sections

@ Click here for additional tips to analyze the Quality Report

Summary i ]
Project Vuelo 1y2
Processed 2022-01-20 17:00:02
Camera Model Name(s) FC6310R_8.8_5472x3648 (RGB)
Average Ground Sampling Distance (GSD) 3.14cm/1.24in
Area Cowered 1.008 km?2/ 100.8355 ha / 0.39 sq. mi. / 249.2988 acres
Quality Check (7]
@ Images median of 63781 keypoints per image 2
@ Dataset 973 out of 973 images calibrated (100%), all images enabled (]
@ camera Optimization 0.41% relative difference between initial and optimized internal camera parameters (]
@ Matching median of 9096.14 matches per calibrated image O
@) Georeferencing yes, 21 GCPs (21 3D), mean RVS error = 0,344 m A
@ Preview i ]

Figure 1: Orthomosaic and the corresponding sparse Digital Surface Model (DSM) before densification.



Calibration Details

Number of Calibrated Images 973 out of 973
Number of Geolocated Images 973 out of 973

@ Initial Image Positions
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Figure 2: Top view of the initial image position. The green line follows the position of the images in time starting from the large blue dot.

@ Computed Image/GCPs/Manual Tie Points Positions
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Figure 3: Offset between initial (blue dots) and computed (green dots) image positions as well as the offset between the GCPs initial positions (blue crosses) and
their computed positions (green crosses) in the top-view (XY plane), front-view (XZ plane), and side-view (YZ plane). Dark green ellipses indicate the absolute
position uncertainty of the bundle block adjustment result.



@ Absolute camera position and orientation uncertainties (i ]

X[m] Y[m] Z[m] Omega [degree] Phi [degree] Kappa [degree]
Mean 0.006 0.006 0.007 0.003 0.003 0.002
Sigma 0.000 0.000 0.001 0.001 0.001 0.001
@ ove rlap i ]

Number of overlappingimages: 1 2 3 4 5+

Figure 4: Number of overlapping images computed for each pixel of the orthomosaic.
Red and yellow areas indicate low overlap for which poor results may be generated. Green areas indicate an overlap of over 5 images for every pixel. Good
quality results will be generated as long as the number of keypoint matches is also sufficient for these areas (see Figure 5 for keypoint matches).

Bundle Block Adjustment Details (i}

Number of 2D Keypoint Observations for Bundle Block Adjustment 9907823
Number of 3D Points for Bundle Block Adjustment 3288960
Mean Reprojection Error [pixels] 0.133

@ Internal Camera Parameters

8 FC6310R_8.8_5472x3648 (RGB). Sensor Dimensions: 12.833 [mm)] x 8.556 [mm] (i ]

EXIF ID: FC6310R_8.8_5472x3648

Focal Principal Principal
Length Point x Pointy il R RS Ui 12
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The correlation between camera internal parameters
determined by the bundle adjustment. White indicates a full
correlation between the parameters, ie. any change in one can
be fully compensated by the other. Black indicates that the
parameter is completelyindependent, and is not affected by
other parameters.

T2

The number of Automatic Tie Points (ATPs) per pixel, averaged over all images of the camera model,
is color coded between black and white. White indicates that, on average, more than 16 ATPs have
been extracted at the pixel location. Black indicates that, on average, 0 ATPs have been extracted at
the pixel location. Click on the image to the see the average direction and magnitude of the re-
projection error for each pixel. Note that the vectors are scaled for better visualization. The scale bar
indicates the magnitude of 1 pixel error.

@ 2p Keypoints Table i ]
Number of 2D Keypoints per Image Number of Matched 2D Keypoints per Image
Median 63781 9096
Mn 41713 336
Max 78546 31093
Mean 63451 10183
@ 3D Points from 2D Keypoint Matches i ]
Number of 3D Points Observed
In 2 Images 2077929
In 3 Images 576387
In 4 Images 241694
In 5 Images 127726
In 6 Images 76238
In 7 Images 48034
In 8 Images 33596
In 9 Images 24326
In 10 Images 18036
In 11 Images 13323
In 12 Images 10380
In 13 Images 8340
In 14 Images 6814
In 15 Images 5471
In 16 Images 4438
In 17 Images 3577



In 18 Images
In 19 Images
In 20 Images
In 21 Images
In 22 Images
In 23 Images
In 24 Images
In 25 Images
In 26 Images
In 27 Images
In 28 Images
In 29 Images
In 30 Images
In 31 Images
In 32 Images
In 33 Images
In 34 Images
In 35 Images
In 36 Images
In 37 Images
In 38 Images
In 39 Images
In 40 Images
In 41 Images
In 42 Images
In 43 Images
In 44 Images
In 45 Images
In 46 Images
In 47 Images
In 48 Images
In 49 Images
In 50 Images
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2821
2337
1804
1504
1084
840
591
515
351
204
145
106

- N N B (o2}
S22 RIIINIRS

= =2 N O~ WO



25 222 444 666 888 1111 1333 1555 1777 2000

Number of matches

Figure 5: Computed image positions with links between matched images. The darkness of the links indicates the number of matched 2D keypoints between the
images. Bright links indicate weak links and require manual tie points or more images.

Geolocation Details (5



@ Ground Control Points i ]

GCP Name Accuracy XY/Z [m] Error X[m] Error Y [m] Error Z[m] Projection Error [pixel] Verified/Marked
30 (3D) 0.020/0.020 1.355 0.529 -0.094 0.770 10/10
31(3D) 0.020/0.020 1.338 0.351 -0.013 1.001 10/10
33(3D) 0.020/0.020 0.953 0.484 0.060 0.739 10/10
34 (3D) 0.020/0.020 0.809 -0.111 0.084 1.086 12/12
36 (3D) 0.020/0.020 0.655 0.099 0.019 1.222 11/11
37 (3D) 0.020/0.020 1.026 -0.280 -0.013 0.968 14/14
38 (3D) 0.020/0.020 0.752 -0.267 -0.013 1.051 12/12
40 (3D) 0.020/0.020 0.046 -0.019 0.088 0.886 10/10
41 (3D) 0.020/0.020 -0.228 0.258 0.041 0.753 10/10
42 (3D) 0.020/0.020 -0.254 0.150 -0.078 0.895 14/14
43 (3D) 0.020/0.020 -0.153 -0.176 -0.095 0.723 8/8
46 (3D) 0.020/0.020 -0472 0.234 -0.249 0.708 8/8
47 (3D) 0.020/0.020 -0.148 0.516 0.046 1.276 12/12
49 (3D) 0.020/0.020 -0.241 0.231 0.145 2291 19/19
50 (3D) 0.020/0.020 -0.055 0.034 -0.096 0.747 6/6
51 (3D) 0.020/0.020 -0.258 0.203 0.006 0.873 10/10
53 (3D) 0.020/0.020 -0.136 -0.177 -0.283 1.298 13/13
54 (3D) 0.020/0.020 -1.209 0.050 0.015 0.857 10/10
55 (3D) 0.020/0.020 -0.911 0.192 0.010 1.064 11/11
56 (3D) 0.020/0.020 -0.354 0.031 0.066 0.995 14/14
57 (3D) 0.020/0.020 -0.181 -0.177 -0.048 1.207 20/20
Mean [m] 0.111095 0.102657 -0.019181

Sigma [m] 0.688630 0.241799 0.101972

RMS Error [m] 0.697534 0.262689 0.103760

Localisation accuracy per GCP and mean errors in the three coordinate directions. The last column counts the number of calibrated images where the GCP has
been automatically verified vs. manually marked.

@ Absolute Geolocation Variance i ]
Mn Error [m] Max Error [m] Geolocation Error X[%)] Geolocation Error Y [%)] Geolocation Error Z [%)]
- -0.06 0.00 0.00 9.25
-0.06 -0.05 0.00 0.00 1.13
-0.05 -0.04 0.41 0.31 3.19
-0.04 -0.02 1.95 3.80 432
-0.02 -0.01 493 5.34 13.26
-0.01 0.00 41.42 40.90 18.29
0.00 0.01 45.63 41.73 17.37
0.01 0.02 432 3.19 11.31
0.02 0.04 1.03 144 6.47
0.04 0.05 0.21 0.92 2.77
0.05 0.06 0.10 144 2.67
0.06 - 0.00 0.92 9.97
Mean [m] -0.202765 0.258916 0.084909
Sigma [m] 0.009071 0.014102 0.079369
RMS Error [m] 0.202968 0.259300 0.116228

Min Error and Max Error represent geolocation error intervals between -1.5 and 1.5 times the maximum accuracy of all the images. Columns X, Y, Z show the
percentage of images with geolocation errors within the predefined error intervals. The geolocation error is the difference between the initial and computed image
positions. Note that the image geolocation errors do not correspond to the accuracy of the observed 3D points.

Geolocation Bias X Y z
Translation [m] -0.202435 0.258309 0.081902

Bias between image initial and computed geolocation given in output coordinate system.



@) Relative Geolocation Variance

Relative Geolocation Error

[-1.00, 1.00]

[-2.00, 2.00]

[-3.00, 3.00]

Mean of Geolocation Accuracy [m]
Sigma of Geolocation Accuracy [m]

Images X[%] Images Y [%] Images Z[%]
85.10 81.71 63.62

95.27 90.54 79.14

98.87 94.66 85.82
0.011050 0.011050 0.027025
0.000887 0.000887 0.005598

Images X, Y, Z represent the percentage of images with a relative geolocation error in X, Y, Z.

Geolocation Crientational Variance
Omega

Phi

Kappa

RMS [degree]
1.881
0.829
2453

Geolocation RMS error of the orientation angles given by the difference between the initial and computed image orientation angles.

Initial Processing Details o
System Information i ]
CPU: Intel(R) Core(TM) i5-8600 CPU @ 3.10GHz
Hardware RAM 48GB
GPU: NVIDIA GeForce GTX 1080 Ti (Driver: 22.21.13.8233)

Operating System Windows 10 Pro, 64-bit
Coordinate Systems [ ]

Image Coordinate System WGS 84

Ground Control Point (GCP) Coordinate System WGS 84 / UTMzone 20S

Qutput Coordinate System WGS 84 / UTMzone 20S
Processing Options i ]

Detected Template No Template Available

Keypoints Image Scale Full, Image Scale: 1

Advanced: Matching Image Pairs Perial Grid or Corridor

Advanced: Matching Strategy Use Geometrically Verified Matching: no

Advanced: Keypoint Exiraction Targeted Number of Keypoints: Automatic

Calibration Method: Standard
b (R Internal Parameters Optimization: All prior
REENEEIRCE e External Parameters Optimization: All
Rematch: Auto, no

Point Cloud Densification details o
Processing Options i ]

Image Scale multiscale, 1/2 (Half image size, Default)

Point Density Optimal

Mnimum Number of Matches 3

3D Textured Mesh Generation yes



3D Textured Mesh Settings:

LOD

Advanced: 3D Textured Mesh Settings
Advanced: Image Groups

Advanced: Use Processing Area
Advanced: Use Annotations

Time for Point Cloud Densification
Time for Point Cloud Classification

Time for 3D Textured Mesh Generation

Results

Number of Generated Tiles
Number of 3D Densified Points

Average Density (per m3)

Resolution: Medium Resolution (default)
Color Balancing: no

Generated: no

Sample Density Divider: 1
group1

yes

yes

03h:53m:40s

32m:52s

20m:20s

6

114963736

93.16

DSM, Orthomosaic and Index Details

Processing Options

DSMand Orthomosaic Resolution

DSMFilters

Raster DSM

Orthomosaic

Raster DTM

DTMResolution

Contour Lines Generation

Time for DSM Generation

Time for Orthomosaic Generation
Time for DTM Generation

Time for Contour Lines Generation
Time for Reflectance Map Generation
Time for Index Map Generation

3 [cm/pixel]

Noise Filtering: yes
Surface Smoothing: yes, Type: Sharp

Generated: yes
Method: Inverse Distance Weighting
Merge Tiles: yes

Generated: yes

Merge Tiles: yes

GeoTIFF Without Transparency: no
Google Maps Tiles and KML: no

Generated: yes
Merge Tiles: yes

15 [cm/pixel]

Generated: yes

Contour Base [m]: 0

Elevation Interval [m]: 0.5
Resolution [cm]: 100

Mnimum Line Size [vertices]: 20

56m:08s
01h:55m:26s
35m:58s
03s

00s

00s



ANEXO 11
MANUALES DE HEC - RAS E IBER



MANUAL HEC-RAS
e Iniciando con el modelo HEC-RAS

Una vez instalado el HECRAS 5.0 se tiene que cambiar el sistema de unidades: Options >
Unit System (US customary SI)

Luego se mostrard la siguiente ventana en el que se predefinira un sistema internacional para
los préximos proyectos.

HEC-RAS 5.0.0 Beta October 2014 =i
File Edit Run View Options GISTools Help

=[8] XelEa] =l (AR = 2 A =R Nl

ject: ELAPROGRAMAS\HEC RAS 2D\Ej 11 1.pr) [=|
Plan:

Geometry: Select Units System

Steady Flow: " Us Customary

Unsteady Flow: (% System International (Metric System)

Description : [V Setas default for new projects!

[.]J[Hec-RAS 5.0.0  [StUnits

e Crear un nuevo proyecto

Para generar un nuevo proyecto se tiene que realizar los siguientes pasos: File > New Project

Se asigna el titulo del proyecto y el nombre del archivo en el que se quiere guardar. A

continuacion, se muestra la ventana que debe aparecer para crear un nuevo proyecto.

HEC-RAS 5.0.0 Beta October 2014 S
File Edit Run View Options GISTools Help

(2 1|5 2 0 I o S 8 2 1 A N [ s e J
Project: Eil [C:WUsers\PC\Desktop\GABRIELA \PRO VHEC RAS 2D\E)1Ej1.p1)
Title File Name Selected Folder  Default Project Folder |  Documents |
f |3 C:\....\PC\Desktop\GABRIELA\PROGRAMAS\HEC RAS 20\E)1
E1 EjL.pg =T
users
=l
Desktop
(JGABRIELA
{C3PROGRAMAS
JHEC RAS 2D

o« | Cancel | Hep | CreateFolder ... | [Sc: 106614000 =l
et drive and path, then enter a new project title and file name.




e Adicionando el Modelo Digital de Elevacion

Para adicionar nuestro MDE debemos seleccionar la herramienta de “RAS Mapper” en el

menu superior. Una vez seleccionada la herramienta, se abrira una ventana.

Esta herramienta basicamente nos permite adicionar datos topograficos, criar geometrias que

seran procesadas Yy visualizar nuestros resultados.

RAS Mapper
File Tools Help

LOAQAX R eriu BEEMS V| vin|d

- [] Features

i [] Results
[] Map Layers
[ Terrains

Messages | Views | rofile Lines | Active Fe « | »

Festures

Una vez definido el sistema de proyeccion para nuestro proyecto, adicionamos el MDE del

area de estudio. Para esto, seleccionamos la herramienta Terrains, donde habilitard una nueva

ventana en la cual seleccionaremos el simbolo (+) que nos permitird escoger el archivo del

MDE.

B RAS Mapper
File Project Tools Help

[ [[]Featwres
[[] Geometries

- [[] Event Condibions
[ Results

‘ [ Map Layers

f@ Download Terrain Data

% Create a New RAS Temain
'  Add an Existing RAS Terrain

UsGs

|

e Definiendo la geometria

Como primera etapa para definir la geometria, se debe crear un archivo donde se guardaran

todas las especificaciones de geometria que seran utilizadas para las simulaciones.



Para esto, seleccionamos la herramienta “Geometries>Add New Geometry” dentro del Ras

Mapper.

Una vez creado este archivo, se habilitaran diferentes opciones que nos permiten comenzar

a definir la geometria

En la segunda etapa se debe delimitar el area de interés, que sera el dominio que el modelo
utilizara para propagar los hidrogramas. Para esto, seleccionamos dentro de las opciones de
geometria la herramienta ‘“2D Flow Area>Perimeters>Edit Geometry”. Una vez seleccionada

esta herramienta se habilitaran las opciones de edicion.

Una vez realizada la delimitacion del area de interés, se debe configura y especificar el
dominio, en relacion al tamafio de las células, numero de Manning, entre otros. Para esto, se

debe dar “click” derecho en la opcion de “2D Flow>Edit 2D Area properties”.

Tamaiio de
célula

B 2D Flow Area Egftor L
2D Flow Area: [FB_—ZD—E
Cell Propetties |

Computation Points

Points Spacing (m) DX: I % DY 5 JMesh State = UnknownErmor

™ Include Shift (m) Number of Cells = 0
Average Face Length =0
Average Cell Size =0
Maxdimum Cell Size = 0 R
Minimum Cell Size = 0 Coeficiente de
I Generate Computation Points | | _,ﬂ g e e Manning
Hydraulic Cell/Face Properties
I Default Manning's n Value: m _{2] Compute Property Tables I
Force Mesh Recomputation Close

La tercera y ultima etapa para definir la geometria, esta relacionado a las condiciones de
contorno aguas arriba y aguas abajo de los canales que seran simulados. Para esto,
seleccionamos la herramienta “Boundary Condition Lines”. Las condiciones de contorno

deben ir definidas afuera del area de dominio,

Una vez creada y definida toda la geometria en el RAS Mapper, se adicionara esta al modelo
principal. Para esto, cerramos el RAS Mapper y navegamos hasta la opcion de geometria en
la interfaz principal del modelo HEC-RAS. Para abrir la geometria, debemos seleccionar

“File>Open Geometry”.



Luego de verificar que la geometria se haya cargado y que este con todas las especificaciones
realizadas en los items anteriores de este manual, podemos guardarla y estamos listos para

realizar las simulaciones.

e Configuracion de las condiciones de entrada y salida para régimen no

permanente

Se realizaran las simulaciones en régimen No Permanente a partir de los hidrogramas
generados en la modelacion Hidrolégica para diferentes periodos de retorno. Para esto,
seleccionamos la opcion Unsteady Flow Data

File Edit Run Vi aens  GIS Tools Help

=[Q) Yo | Y| Gl ol L[5 Llx]E = ~|#|Z[E|e
jmandala

ClmleEss gl

Project: [C:\Users\Marina\Desktop\Mandala\4_Projeto\mandala.prj o
Plan: Plan 02 [C:\Users\Marina\Desktop\Mandala\4_Projeto\mandala.p02

Geometry: _2D_mandala IC:\Users\Marina \Desktop\Mandala\4_Projeto\mandala.g02

Steady Flow: | |

Unsteady Flow: hao_perma_1208 [C:\Users\Marina\Desktop\Mandala\4_Projeto\mandala,u01

Description : | .| [STUnits

Aqui, se van a configurar las condiciones de contorno, tanto de entrada como de salida.

Como condiciones de entrada, se adicionan los hidrogramas que seran propagados por el
modelo. Para este ejemplo, todos los hidrogramas para cada una de las subcuencas se 10s
puede obtener en la carpeta “02_EXCEL”.

Valores del
hidrograma

l

Adicionar la f ‘/E

pendiente



En seguida, se habilitard una nueva ventana donde se especificaran informaciones en relacion

al tiempo de simulacién y ajustes de calculo computacional.

.4 Unsteady Flow Analysis [ x |
File Options Help
Plan: [ short ;|

Geometry File : | =]
Unsteady Flow Fie : | =

Programs to Run Plan Description

¥ Geometry Preprocessor

¥ unsteady Flow Simuation

™ sedment

AR Definir fecha y hora de

¥ Floodplain Mapping simulacion.

Simulation Time Window a

Starting Date: [E]  startig Time:

Ending Date: 2| endng Time: [
LComoutation
Computation Interval:  |iMnute  v| ..| Hydrograph QutputInterval: [1Hour  ~|

Mapping Output Interval: |1 Hour Detaied Output Interval: 1Hour v

DSS Output Fiename:  [dss &

Definir
intervalos
de
simulacion.

Compute |

e Visualizacién de los Resultados

Una vez finalizada la simulacion podemos visualizar sus resultados. Para esto selecionamos
la opcion RAS Mapper. Aqui, se puede observar y exportar los diferentes raster profundidad
y velocidad, como los poligonos de las areas suceptibles de inundacion. Estos productos son

la base para aplicar metodologias para zonificacion de amaneza de inundacion.



MANUAL DE IBER
e Crear o importar una geometria

Para importar una geometria es necesario en primer lugar guardar el proyecto con un nombre.
El proyecto se guarda en el ordenador como una carpeta con el nombre del proyecto y

extension. gid.

=
Directorio: Iber - || B |8 Previsualizar [_] Ensefiar ocultos

No hay previsualizacién

lI‘Save options

MNombre del archivu:jCUtagaita‘IZi ] Salvar

Archivos de tipo: proyecto [BER (*.gid) L| Cancelar

IBER dispone de una interfaz en la cual se puede crear una geometria desde el inicio,
dibujando puntos (directamente o entrando coordenadas), lineas y superficies. Por otro lado,
desde el menu “Archivo>Importar” se pueden importar distintos formatos estdndar (dxf,
shapefile, entre otros). Asimismo, a través del mend “IBER Herramientas” se pueden

importar modelos digitales del terreno en formato ASCII de Arc-Info.

Una vez creada o importada una geometria es posible editarla y modificarla con las opciones

bajo el mend Geometria.
e Meni “IBER_Herramientas > RTIN”

Con este menu se puede crear e importar una geometria formada por una red irregular de

triangulos rectangulos (RTIN).

Con el submenu crear RTIN se selecciona el archivo ASCII del MDT, y se crea un archivo
“rtin.dxf” dentro de la carpeta del proyecto IBER. Al crearlo se debe indicar la longitud
minima y maxima de lado de los tridngulos que se formaran, asi como una tolerancia
(méaxima distancia en vertical entre el MDT y la geometria creada) que debe de ser del orden
de la precision altimétrica del MDT.



Calcular Herramientas Iber  Ayuda

P Laye MOT » 5% 2 | 1
RTIN Crear RTIN... l
Malla »

Via Intenso Desagie  »

Con el submenud importar RTIN se importa la RTIN creada. Para ello se debe seleccionar el
archivo “rtin.dxf” creado dentro de la carpeta del proyecto. Una vez importado el archivo
RTIN se debe colapsar el modelo ya que los triangulos se han importado como triangulos
independientes, es decir, sin compartir una sola linea como lado comun. El colapso puede
tardar bastante tiempo, por lo que se permite cancelar el proceso si se desea modificar la
RTIN importada.

RTIN Importado

0 Se ha importado RTIN.dxi.
Quiere colapsar la geometria?

Ot | o
FRTS Medos 540 Dt TR40 i Nt [ SR

e Condiciones hidrodinamicas

Condiciones de contorno de entrada

Existe la posibilidad de asignar un caudal total, un caudal especifico (caudal por unidad de
ancho), o una cota de agua. En cada caso se exigiran los pardmetros necesarios en funcién de

si el régimen es subcritico, critico, o supercritico.



Analisis 2D n

Entrada 2D v x? 2
Entrada Caudal Total -
Régimen Critico/Subcritico -
Caudal Total Tiempo [s] | Q[m3/s] X

Entrada Num|1

"‘ Entidades Dibujar Desasignar

Cerrar

e Condiciones internas

Con este menu se pueden asignar distintos tipos de condiciones internas en los lados de los
elementos. Los tipos de condiciones internas consideradas son: vertedero, compuerta,
combinacion de vertedero y compuerta, o un coeficiente de pérdidas localizadas. En los
primeros tres casos, la longitud del vertedero y el ancho de la compuerta se piden como un
porcentaje de longitud del lado, no como longitud absoluta.

e Rugosidad

En IBER la rugosidad se asigna a través de un coeficiente de rugosidad de Manning.

D M Lt Ay
P I e Bttt vt Snten ey Camwen  Wadees Wy
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e Asignacion segun usos del suelo

Con el menu “Rugosidad > Usos del suelo” se abre la posibilidad de escoger un uso del suelo
y asignarlo a las superficies que forman la geometria (0 en su caso a los elementos de la
malla). Existen unos valores predeterminados asignados a cada uso del suelo, pero estos

pueden cambiarse. También se pueden afiadir o eliminar usos del suelo.
e Asignacion automatica con datos georeferenciados

La asignacion automatica del coeficiente de rugosidad se realiza desde el menu: “Datos

>Rugosidad > Asignacion automatica”.

Este men( abre una ventana de seleccion donde el usuario puede escoger el tipo de archivo
desde donde se leerd la informacion de usos del suelo. IBER tiene implementados dos
formatos, el formato estdndar ASCIlI Grid Arcinfo y un formato XY definido
especificamente. En ambos casos debe existir en el mismo directorio un archivo *.csv que
contenga la lista del tipo utilizado, que ademés deberan coincidir con los existentes en la base
de datos del programa. Si las clases no existieran pueden crearse dentro de la base de datos

mediante la ventana de asignacion manual mencionada en el sub-apartado anterior.

Una vez seleccionado el formato deseado se acepta y se abrira una ventana desde donde
escoger el archivo. Al escoger el archivo adecuado y aceptar, el programa lee la informacion
y automaticamente asigna a los elementos de la malla el coeficiente de Manning que les

corresponde.
e Procesos hidrologicos

En el ment “Datos > Procesos hidrologicos” se puede asignar un hietograma y distintas
funciones de pérdidas por infiltracion sobre las superficies de la geometria o los elementos

de la malla.

Lluvia La lluvia se asigna en forma de hietograma. Cada instante de tiempo del hietograma
indica el inicio de un bloque de precipitacion de intensidad constante que se mantiene hasta

el préximo instante de tiempo.



e Mallado

La malla de célculo es un elemento fundamental para conseguir buenos resultados. IBER
dispone de multitud de maneras de obtener una buena malla de célculo, y en funcion de las

caracteristicas del problema un tipo de malla sera mejor que otro.

IBER puede trabajar tanto con elementos triangulares como con cuadrilateros, o con mallas
mixtas de triangulos y cuadrilateros. Las mallas de calculo pueden ser a su vez regulares o

irregulares, asi como estructuradas o no estructuradas.
Las caracteristicas de la malla se asignan con los siguiente menus:

e El menu “Utilidades > Preferencias > Mallar” fija las opciones generales de mallado.

e Con el menu Malla se fijan las propiedades de la malla asignadas a la geometria.
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e Menu “IBER Herramientas > Editar Malla”

Una vez se ha generado una malla, es posible modificar la cota de los vértices de la malla
interpolando las cotas leidas de un archivo correspondiente a un modelo de terreno en
formato ASCII de Arc Info. Esto es de utilidad tanto para poder generar una malla a cota cero
(por ejemplo, utilizando una fotografia georeferenciada de fondo), y luego asignarle cota a
los vértices, como para modificar una geometria existente. EI modelo de terreno puede
abarcar todo el dominio cubierto por la malla, o solo una parte. El archivo con las cotas de

los vértices se carga con “IBER herramientas > Editar malla > Mover nodos”



e Ejecucion de un célculo

Para lanzar un célculo, en primer lugar, se deben fijar los pardmetros de célculo, o datos del
problema, mediante las distintas pestafias del menu “Datos > Datos del problema”. En el

siguiente sub apartado se explican las distintas opciones de dicho mend.

El céalculo se lanza con el menu Calcular. A través de dicho menl es posible lanzar
directamente el calculo (“Calcular > Calcular”) o acceder a la ventana de calculo (“Calcular
> Ventana de calculo”). Esta segunda opcion permite tener un mejor control del proceso de
calculo, o acceder al archivo que muestra el estado del proceso (Boton Ver salida), mientras

el célculo se esta ejecutando.

La ventana de informacién del proceso también se abre, durante el proceso o cuando éste ha
finalizado, con el menu “Calcular > Ver informacion del proceso”. Es conveniente consultar

dicha informacidn para detectar posibles avisos de errores.
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Comar

e Parametros del célculo
Se accede a través del menu “Datos > Datos del problema”.

Una vez finalizado el célculo, o durante el mismo, se puede acceder al post-proceso para

visualizar y analizar los resultados. ElI cambio entre las interfaces de pre-proceso y post-



proceso se realiza mediante el menu “Archivo > postproceso” y “Archivo > preproceso”, o

mediante los botones correspondientes de la barra de herramientas.
e Visualizacion de resultados

Iber dispone de multitud de opciones para visualizar y analizar los resultados, personalizar
los colores, las leyendas, mostrar etiquetas de valores, etc. Una opcidn para visualizar
resultados es mediante el ment “Ventana > ver resultados”. La ventana que se abre permite
acceder a los distintos grupos de resultados (0 Analisis) que se pueden visualizar en cada

instante de tiempo, como areas coloreadas, areas coloreadas suavizadas, o vectores.
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e Creacion de graficos

Con los distintos botones de creacidn de graficos de la barra de visualizacion de resultados
(botones evolucion de punto, grafico de linea, grafico punto y gréafico de borde) es posible
crear graficos de utilidad para el andlisis de resultados. Los graficos creados de pueden
gestionar con la ventana de graficos (“Ventana > ver graficos”) y se pueden exportar para

abrirlos, por ejemplo, en Excel con “Archivo > Exportar > Grafico”.



e Exportar resultados en formato raster

Iber permite exportar la mayoria de resultados en formato ASCII grid de Arc Info a través
del ment “Iber Herramientas > Resultados en Grid”. So6lo se debe seleccionar un resultado,

introducir el valor de un instante de tiempo y un tamafio de celda.

IBER creara una carpeta dentro de la carpeta del proyecto actual (carpeta Grids of results), y
dentro de la misma los archivos en formato ASCII de los resultados seleccionados en el

instante de tiempo mas préximo al solicitado.



ANEXO 11

MEMORIA FOTOGRAFICA

Desborde del rio Salinas

Desborde del rio Salinas al borde de la empresa AGRONAYADE



Ingreso de escombros a los cultivos

Consecuencia de la inundacion en la produccion de arandanos



Darios en las casetas de riegos



Q La Voz de Tarija

Pérdida de cultivos e inundaciones,
Entre Rios en emergencia tras sufrir
una riada

miércoles, 16 enero 2019 - 11:25 AM - Gabriela Flores
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El alcalde de Entre Rios, Nicolas Herrera, ha informado que tras sufrir una
riada en horas de la madrugada han sufrido pérdidas de cultivos,
afectacion en viviendas y ademas cierre de carreteras, segun ha explicado
tanto el rio Pajonal, rio Santa Ana y rio Salinas se han desbordado causando
estragos en ambos lados de la provincia.

N3s &S Qusta esto Sé

70 08 1US 3MIgos.

«Lamentable la situacién con la que amanecemos en la provincia O'Connor, en
nuestra capital de provincia, una crecida bastante grande de nuestro rio tanto
el Pajonal como el Santa Ana que nos ha complicado bastantemente, el
agua se ha entrado a las calles de Entre Rios afectando a las viviendas»,

«Una situacion mas complicada aun lo que son las comunidades en las distintas
areas productivas, se ha inundado los potreros, se ha llevado cultivos,
diferentes tipos de cultivos entendemos que arandano, maiz, mani que
estaban en plena etapa de crecimiento han sido afectados en una gran
cantidad de hectareas en toda la jurisdiccion de nuestra provincia en ambos
margenes del rio», ha sefialado.

Periddico La voz de Tarija



Google Earth

AGRONAYADE
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Imagen satelital de la propiedad de AGRONAYADE- Naranjos 1
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